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1 Welcome to Knorg

Welcome to the future of knowledge management. 

Knorg (short for KNowledge ORGanizer) is a stand-alone knowledge management tool that lets you to:

· collect, manage and organize any type of on-line or off-line content (HTML, PDF, DOC, RTF, and
any other document type with a properly installed IFilter)

· download and save anything you find on the Web via simple drag and drop operations
· categorize and organize your documents in a way you want. All files are placed into appropriate

categories, with or without user's involvement.
· define rules for automatic document categorization
· perform fully automated "auto-categorization" based on the similarity of documents already stored in

your categories
· attach tags and descriptions to your stored documents
· perform powerful full-text searches
· listen to system clipboard and extract relevant content (URLs and files)
· share your knowledge and organize ad-hoc P2P networks to search for information stored on your

peer's machines
· import bookmarks from virtually any browser
· export links stored inside your categories to services like del.icio.us

How it is done

Knorg combines and improves the functionality found in the following types of software:

· personal information managers
· research assistants
· clipboard watchers
· bookmark organizers
· content taggers
· full text search engines
· offline browsers
· peer-to-peer clients

The whole can often be greater than the sum of its parts: similarly, Knorg offers unique functionality
that surpasses document organization and knowledge management tools that were available until
now. It is an ideal tool for professional researchers and journalists, software developers that work
alone or in teams, students, teachers, lawyers, doctors, hobbyists... What's best, using it doesn't
require hours of training since it features familiar, Outlook-style user interface.

http://www.ifilter.org/
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2 Introduction

The topics in this section provide some basic information about Knorg, its functionality and general
usage scenarios.

2.1 Why Knorg?

Finding information on the Web is a challenge by itself, not to mention storing and retrieving them later
on. There are many tools that will help you fight the information overload, but most of them are solving
only a single aspect of this multi-dimensional problem. 

For example, a browser favorites (bookmarks) tool will only save the page URL/title. Every larger
bookmark collection tends to become quite unmanageable as it grows. Even larger problem lies in the
fact that the particular document or a site can change or become inactive until your next visit. A
collection of "dead" or inaccurate links will not really help you do anything.

Several "offline browsers" claim that they can bring solution to this problem by saving online content for
a later review - whenever you want and need it. Again, this solves only one aspect of the bigger
problem: your disks can quickly become cluttered with the downloaded content. The structure of a
typical HTML document makes the situation even worse - HTML documents are not "self-contained",
and they can contain links to many external resources (not only hyperlinks, but also images, stylesheet
files, scripts and similar files that are essential for the proper look of the downloaded file). Some users
revert to various desktop search engines that can indeed help you find the information more quickly,
but still cannot help you categorize and share your document collections. Full text search is indeed a
valuable feature in every knowledge management toolbox, and with addition of proper categorization
and tagging schemes it can save you hours and help you become much more productive.

Knorg is more efficient... and more fun!

Once started, Knog sits in the system tray and waits for user actions. 

There are multiple ways to store a document to Knorg's archive. You can either instruct it to listed to
the system's clipboard: whenever it detects an URL or a file (or several files) are being copied, it will
copy the target document(s) and move them to the appropriate categories. 

You can also drag a file or an URL from the browser to the "drop form" that pops-up from the tray - you
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can decide whether to store it to the explicit category or leave the program to automatically assign it to
the target category. 

It is really easy to define rules that are used to store files to appropriate categories. It is also possible
to let the system calculate the document similarity based on the existing documents and perform the
whole process automatically... just like magic.

But that's only the beginning: Knorg features a rich user interface that will be very familiar to most of
the users (more on that in the User interface section). It preserves the integrity of downloaded HTML
files (all files are stored in a single file archive). It allows you to perform full text searches on both your
local machine and all machines in your P2P community. It can import and download documents from
links in your browser favorites/bookmarks collection, allowing you to instantly initialize and fill a rich
knowledge base. It allows you to annotate and assign tags to your documents, creating an alternative
navigational system (besides category folders and full text search)... This list could go on and on -
each feature is described in detail in the following sections.

2.2 Installation

Knorg installation is relatively straightforward. The only prerequisite is Microsoft's .NET framework 2.0
or higher. There are three basic installation steps:
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1. Choose the installation directory

2. Choose a directory that will be used as a root of your knowledge base. If you want to use Network
search features, please check the "Enable P2P sharing..." checkbox and make sure that the port that
is entered here is not blocked by your firewall. You also need to enter the address of the P2P
coordination server. You may optionally enter your e-mail address if you want to receive mail
messages from other users (your address will not be visible to them).
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3. Choose database type you want to use. MS Access does not require any additional software, while
MS SQL Server requires that you have SQL Server 2005 or SQL Server Express installed on your
machine or somewhere on your local network. SQL Server is a more scalable solution - however, for
moderately-sized knowledge bases there will be no special performance gains or issues with both
types.

2.3 Getting help

This help is designed to be used on-screen. The PDF version and all updates are available at our Web
site. Both references cover program functionality in every detail.

Our Web site also offers a support forum that can be used to contact the support staff and other
users. 

You can also contact our support team directly at support@mono-software.com.

2.4 How to buy

You can download free trial versions from our Web site. Trial version is time-limited and does not allow
storing more than 50 documents in the knowledge base.
You can buy Knorg using our online shop using all major credit cards, PayPal, money orders and other
standard payment methods. As soon as your transaction is completed you will be able to download

http://www.knorg.net
http://www.knorg.net
http://www.knorg.net/forum.htm
mailto:support@mono-software.com
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and install the program and start working right away.

Direct order link:
http://www.knorg.net/purchase.htm

Mono Software Home Page:
http://www.mono-software.com

Sales:
sales@mono-software.com

Postal address:
Mono Software LLC
Bihacka 1d
HR-31000 Osijek
Croatia

http://www.knorg.net/purchase.htm
http://www.mono-software.com
mailto:sales@mono-software.com
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3 The User Interface

Clear and intuitive user interface is one of the key features Knorg has to offer. The program is build
around the three-pane interface that is very similar to Microsoft Outlook, so it doesn't take more than a
few minutes for an average user to get familiar with it. This section describes each pane and its
functionality.

Knorg User Interface

3.1 The Navigation Pane

The navigation pane (Knorg's leftmost pane) provides centralized navigation and easy access to
document search, tagging, sharing and similar features. 
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Navigation pane, default view

The default view shows category hierarchy. Buttons at the bottom of the page are used to switch
panes - the complete user interface and functionality changes each time a navigation button is clicked.
Alternatively you can use menu items listed under the "Go" menu in the main menu bar to switch
panes.

3.1.1 Categories

The "Categories" section is activated by clicking on a "Categories" button in the navigation pane or by
choosing "Categories" from the "Go" menu.
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This section allows you to manage the category hierarchy: the root folder can be defined using the 
"Program settings" screen. This section features the familiar folder tree view  from Windows Explorer -
all operations (creating, copying, moving, deleting, renaming folders) can be performed using the
context menu that pops-out on right mouse click. Note that you can also rearrange your category
hierarchy via ordinary drag and drop operations (selecting and dragging a category to another category
node will result in a "move" operation).
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This menu also allows you to toggle the sharing status of each individual category: only documents
from the shared folders (indicated by a different folder icon) will be available to other users via network
search.
You can alternatively use items from the "Folder" menu to manage categories. This menu features two
additional options that are used for importing bookmarks/favorites from browsers like Microsoft
Internet Explorer or Firefox; and exporting document links to del.icio.us

3.1.2 Search

The "Search" section is activated by clicking on a "Search" button in the navigation pane or by
choosing "Search" from the "Go" menu.

http://del.icio.us/
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This section allows you to perform fast and powerful full-text searches on your local knowledge base.
Full text query syntax and options are described in detail in the "Full text search" section. Note that you
can apply additional date-based (modified before, modified on, modified after) and size-based (smaller
than, larger than) filters to your search. A list of stored documents that match your search criteria will
be shown in the document list pane.

3.1.3 Network search

The "Network search" section is activated by clicking on a "Network search" button in the navigation
pane or by choosing "Network search" from the "Go" menu.
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This section allows you to perform fast and powerful full-text searches on machines that are members
of the P2P Knorg search network. It works in the same fashion as the "Categories" module. Since the
network search typically requires more time, the program will interactively display the search status
messages in the panel below the search parameters.

Please note that this section is available only if you have joined the P2P network (you have to define
the P2P coordination server address and local sharing port; both settings can be adjusted using the 
Program settings dialog). Also note that your identity is ALWAYS hidden from other members of the
network; if you decide to enter your e-mail address in Program settings it will be used for exchanging
mail messages between users (like requests for more details on a particular document), but the
sending party will never see the receiver's address.

3.1.4 History

The "History" section is activated by clicking on a "History" button in the navigation pane or by
choosing "History" from the "Go" menu.
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This section enables you to review the download and categorization history for documents in your local
knowledge base. Since multiple documents can be downloaded and stored simultaneously it can
become quite difficult to locate the new documents (especially if they are auto-categorized). This
module sorts documents by their download date, and you can preview each on them by clicking on a
document title.

3.1.5 Tags

The "Tags" section is activated by clicking on a "Tags" button in the navigation pane or by choosing
"Tags" from the "Go" menu.



Knorg Help17

© 2006 Mono Software LLC

This section allows you to tag each document in your knowledge base. A tag is a keyword assigned to
a file so you can easily identify it among hundreds of similar files. You can assign several tags to a
single file. In other words: it is a simple way to keep things organized. 
Tagging has become very popular lately due to the success of services like del.icio.us. Knorg enables
you to easily export links from any of its categories to this service.

You can visualize the tag popularity by using "Tag cloud" tab. It shows the same information as the
basic view, but it is somewhat easier to interpret since more popular tags are displayed with larger
fonts, and all items are colored by they popularity:

http://del.icio.us
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The third tab, "Keywords" lists most popular keywords from your "user profile": it is an aggregate
document vector that holds term frequencies for all terms in the knowledge base. It is sometimes
interesting to see which terms are appearing more frequently that the other; it can also suggest you
which user-defined tags should be included in the tag list. Double clicking on any row in the keywords
table will list all documents that contains the selected keyword.
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3.2 The Document List Pane

The document list pane shows a list of documents in a selected folder or a list of documents matching
your search criteria (if a full-text search is being performed).

Document list, basic view
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Document list, detailed view

This module offers two views: while basic view shows only the title, modification date and a file size,
detailed view additionally displays tags and document description. Double-clicking on each row opens
a document in a separate window. Individual documents can be moved to appropriate categories using
a simple drag and drop operation - just drag a selected row to appropriate category in the "Categories"
section. Various additional options are displayed in the context menu that is available on right mouse
click. Depending on a currently used mode (local preview or search vs. network search), the context
menu will show different menu items:

Local mode

Network search mode

All options presented in a local mode are rather self-explanatory: "Move to" option allows you to specify
the target category you want to move the selected document (the same effect can be achieved with
drag and drop). "Go to original URL" enables you to visit the original Web page (if any, applies only to
documents downloaded from the Web by Knorg).
On the other hand, "Download" option that is displayed in the network search mode enables you to
download the selected document to your local disk. "Contact the owner of this file" opens a dialog box
that is used for direct e-mail communication with the file owner. It is possible only if the owner of the
file agrees to receive such messages by entering his e-mail in the program settings. You cannot see
the owner's e-mail address directly due to privacy protection mechanism.
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3.3 The Content Pane

The content pane displays the currently selected document regardless of its format (HTML, PDF,
DOC, etc.). 
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The content page can be located at the bottom or along the right-hand side of the program main
screen, depending on a selected item in the View - Reading Pane menu option. Internally, it creates an
instance of the Internet Explorer Web browser, so all Explorer's settings (especially security) do apply
to this module. 

The content pane also displays a description and tags for the selected document. To see how to add
and edit these fields, please refer to the section titled "Tagging documents".
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4 Menus and Dialogs

This section provides a reference to the dialogs and options made available by Knorg's menus. 

4.1 The File Menu

This menu provides a list of file management options. 

In addition to the basic file operations, this menu allows you to exit program (by choosing "Close
Knorg"), or to close the main form and let Knorg continue working in the system tray (by choosing "Exit
main form"). It duplicates the functionality from the context menu that is available on right mouse click
over a document in the document list pane.

4.2 The Folder Menu

This menu provides a list of folder management options. 
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This menu duplicates the functionality found in the context menu that is available on right mouse click
over the category node in the categories section of the navigation pane.Additionally it allows you to
import bookmarks from other Web browsers (please make sure that the category node that will serve
as a root of bookmark hierarchy is selected before you run this utility). It also enables you to send all
links from a selected category and its subcategories to del.icio.us.

4.3 The View Menu

This menu provides a list of layout-related options. 

a

· "Arrange By" option is used to change the sorting order in the document list pane.
· "Navigation Pane" option turns the leftmost navigation pane on and off.
· "Content Pane" option is used to switch the content pane between left and bottom borders of the

screen, or to turn it off completely.
· "View Details" option displays tags and description for the each document in the document list pane

when turned on.
· "AutoPreview" option cancels the automatic preview of each document in the content pane as it is

being selected in the document list pane. It can save you time when working with large and complex
documents, but you have to click on the "Refresh" option in the context menu to preview the
document.

· "Refresh" option refreshes the display of the currently selected category.
· "Status bar" option shows and hides program's status bar.

http://del.icio.us
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4.4 The Go Menu

This menu provides a functionality identical to clicking on the buttons in the navigation pane.

4.5 The Tools Menu

This menu provides various configuration options that are the key to the proper functioning of the
whole system.

4.5.1 Knorg search service

Knorg search service indexes all documents in your knowledge base while running in the background.
You can check the status of the service by going into Windows Control Panel -> Administrative tools ->
Services:

This service will be installed during the setup, and you should make sure that it is running at all times if
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you want to have an index that is up-to-date. If you want to remove the search service for any reasons
and later reinstall it, please use the appropriate menu options in the Tools menu.

4.5.2 Rebuilding index

This menu option allows you to delete and rebuild full text index at any time if it becomes corrupted for
any reason.

4.5.3 Rules

This option allows you to build rules that are used for proper categorization of incoming documents. It
is explained in more detail in the section titled "Creating categorization rules".

4.5.4 Program settings

The dialog that is invoked using this menu option allows you to change all program configuration
settings. 
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The list of user-configurable settings is as follows:

· DBType: defines the database type, SQL Server or Access .
· SQLConnectionString: database connection string.
· Email: user e-mail that will be used in case other users of Knorg P2P network want to contact you.

May be left empty if you don't want to receive mail from other users. It will NOT be visible to other
users in any scenario.

· MaxNoOfSearchResults: defines the maximum number of search results that are to be received
from a single server.

· P2PServer: contains the URL of the Knorg P2P coordination server (you may purchase it separately
and install it on your local network or use a public server)

· ServerPort: the port number used for file sharing. It must be opened on your firewall.
· SharingEnabled: set it to true if you want to share files with other users.
· LogAllEvents: when set to true, the program will store all important events in a dedicated database

table.
· NumberOfItemsInHistory: maximum number of items that will be displayed in the history section of

the navigation pane.
· RootFolder: this folder will hold all Knorg's documents and indexes.
· StripIframesFromHtml: specifies if the content form HTML IFrame elements should be retrieved and

saved with the original document.
· StripScriptsFromHtml: specifies if Knorg should download javascripts attached to the original

documents.
· UseAutoCategorization: if set to true the system uses autocategorization feature to place incoming
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files to appropriate categories. No further configuration is required to use this feature, since it uses
keyword signatures from the existing documents to calculate document similarity. It cannot be used
on empty categories!

· UseRuleBasedCategorization: specifies if the system should use user-defined list of rules (regular
expressions) as set using the Rules dialog. This setting will override the UseAutoCategorization
setting.

· HttpAuthenticationUsername and Password, UseHttpAuthentication: used for HttpAuthentication
scheme. You will recognize it by a Windows pop-up box with username and password fields that is
shown when accessing pages protected by it. Note that this is totally different from "forms security",
a cookie-based authentication mechanism that is much more frequently used - Web authentication
dialog is used to access these pages.

· DeliciousUsername and Pasword: enter credentials for your del.icio.us account if you want to export
links from Knorg.

(Proxy settings that were also displayed in the settings screen in the previous versions are now
removed since Knorg automatically detects local proxy settings from the installed instance of Internet
Explorer)

4.5.5 Web authentication

This option is used to access pages that are protected by "forms-based" (cookie) authentication - the
majority of public Web sites uses this type of authentication.
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The process works as follows: you should enter the URL of the page you want to access in the
topmost text area and click on the "Go" button. After the page is loaded you may log-in to the target
site (if not already logged). Press "Fetch authentication settings from the browser" to transfer
authentication settings to Knorg. You will be able to access password-protected pages from that
moment on.

4.5.6 Download queue

This dialog displays the contents of the download queue. Knorg has the ability of multithreaded
(parallel) download of content from multiple pages, so it is sometimes interesting to see how many
links are present in the download queue (especially when importing large bookmark files and
performing similar tasks). 
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4.5.7 Event log

This section displays a list of events from the event log. When configured to use the event log
(program settings - LogAllEvents), the system stores all important messages for a later review. 
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4.5.8 Backup

These menu options allows you to make backup copies of your knowledge base, and to import data
from a backup copy in the case something goes wrong. Backup operation stores all documents,
indexes and the Knorg database in a separate folder. Please make sure that you have enough disk
space in the backup folder before performing backup. 
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5 Using Knorg

The following sections describe the most frequently used operations and procedures in Knorg. Note
that you don't have to use them in the order described here; however, you typically need to create at
least a few categories and store a few documents to start using Knorg productively.

5.1 Creating categories

Category section in the navigation pane is used to create and maintain the hierarchy of your
knowledge base. You should create category hierarchy before attempting to download (or copy) and
store any documents, since otherwise they will all be stored in a single incoming Knorg folder. You
may manage category tree using the folder view and context menu (or main Folder menu), as
described in the "Categories" section of this manual. Categories may be alternatively moved and
rearranged via drag and drop manipulation. 
In essence, working with the categories module is very similar to working with Windows Explorer
"folders" pane.

5.2 Creating categorization rules

Categorization rules are used to explicitly categorize incoming documents by particular keywords they
contain. The "Rules" dialog allows you to enter rule name for easier identification, regular expression
for parsing the document content, and a category to which the document should be moved if a regular
expression attached to this rule fires. You can change the rule priority by using the "arrow" buttons
(Move up and Move down) from the toolbar of this screen.

Regular expressions are programming tools for describing certain patterns in the text. A regular
expression will "fire" when it finds a text that matches it. Although they can become rather complicated,
even simple file system searches using wildcards like "*.txt" (that will match all files with the extension
".txt") show the power of regular expressions. There are various tutorials that will help you understand
the basics of regular expressions (visit http://www.regular-expressions.info/tutorial.html for an example
), and regular expression cheat sheets can also come handy.

Here are the general rules:

You want to match documents that contain term "expression"
Enter expression in the rule box

You want to match documents that contain terms "regular" OR "expression"
Enter regular|expression in the rule box

You want to match documents that contain both terms "regular" AND "expression"
Enter regular.*expression|expression.*regular in the rule box

You may perform arbitrarily complex operations, like this one that emulates the "near" operator (it will
match only the documents with "regular" and "expression" separated by at most 6 words)

Enter \b(?:regular\W+(?:\w+\W+){1,6}expression|expression\W+(?:\w+\W+){1,6}regular)\b
in the rule box

5.3 Auto-categorization

Auto-categorization screen complements the "categorization rules" dialog. It is used to automatically
assign incoming documents to categories they should belong to, based on the document similarity

http://www.regular-expressions.info/tutorial.html
http://regexlib.com/CheatSheet.aspx


Knorg Help35

© 2006 Mono Software LLC

between the incoming documents and documents already present in the category structure. 

There are two important things to remember when using auto-categorization:

1. categorization rules have priority over auto-categorization. Knorg effectively respects your wishes as
expressed in the categorization rules screen, so once a "hardcoded" user rule fires, no other rules
or the auto-categorization procedure will be evaluated

2. you should have a number of documents already placed in the category structure (at least 3-5,
depending on the size and content of those documents) for auto-categorization mechanism to work
correctly. 

The document similarity calculation algorithm works by creating document vectors, where each
document is described through pairs of keywords and the number of keyword occurrences in each
document. Each category has an aggregate vector attached to it, so each time a new document
arrives it is compared to each of the category's vectors to find a best match. 

5.4 Storing documents

There are multiple ways to store a document in Knorg. You can either instruct it to listed to the
system's clipboard: whenever it detects an URL or a file (or several files) are being copied/cut to the
clipboard (via CTRL C, CTRL X, or the equivalent menu options from various programs), it will copy
the target document(s) to the incoming folder and apply categorization rules and/or auto-categorization
algorithm to them:

Tray menu with the "clipboard listener" turned on

You can also drag a file or an URL from the browser to the form that pops-up from the tray - you can
decide whether to store it to the explicit category or leave the program to automatically assign it to the
target category. 

Drag and drop form is used to transfer documents directly into the selected category (when dropped to the tree view on the
bottom), or to apply categorization rules and/or auto-categorization mechanism (when dropped to the upper portion of the form)
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Note that different browsers have different drag and drop mechanisms. Microsoft Internet Explorer
requires you to drag the IE icon as shown below:

Firefox, on the other hand, allows you to select and drag the complete URL from the address box:

5.5 Tagging documents

A tag is a keyword assigned to a file so you can easily identify it among hundreds of similar files. You
can assign several tags to a single file. In other words: it is a simple way to keep things organized. 

Tagging was made popular by various Web 2.0 services such as del.icio.us, Technorati, etc.Tags
allows you to introduce an alternative categorization structure to the knowledge base, so rather than
having to dig through the category hierarchy or using full-text searches, you can simply look up the
files via predetermined keywords. This idea is simple and elegant, and is being widely adopted in
various applications.

The same dialog that is used to attach tags to documents allows you to enter detailed description for
each document.

http://del.icio.us
http://www.technorati.com/
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5.6 Full-text search

Knorg indexes your documents constantly, so all searches return results instantly regardless of the
total size of the knowledge base. Our full text search subsystem utilizes a .NET port of Apache Lucene
, an industrial strength search engine that has a low impact on the system resources, and is very easy
to use for an average user.

Knorg supports the following Boolean operators: AND, "+", OR, NOT and "-" 

text AND mining finds all documents that contain both terms
text OR mining returns documents that have at least one term present
The "+" or required operator requires that the term after the "+" symbol exist somewhere in a
document.
+text mining returns documents that MUST contain the term "text", and they may contain the term
mining
The "-" or prohibit operator excludes documents that contain the term after the "-" symbol.
mining -text will return only documents that contain the term "mining", but without term "text"

http://lucene.apache.org/
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Phrase search:
"text mining" returns documents that contain this exact phrase

To perform a single character wildcard search use the "?" symbol:
te?t - returns documents that contain terms "text", "test", etc.

To perform a multiple character wildcard search use the "*" symbol.
test* - returns documents containing terms test, tester, etc.

More info on advanced search query syntax can be found here: http://lucene.apache.org/java/docs/
queryparsersyntax.html.

5.7 Sharing documents

Knorg's ability to share documents between members of teams of arbitrary size is one of its greatest
strengths. You can choose individual categories that you want to share with the other users and
receive full-text search results from them using the built-in P2P protocol. At the same time, user
privacy is completely protected, meaning that other users cannot know the identity or e-mail of the user
that is publishing the requested documents.

http://lucene.apache.org/java/docs/queryparsersyntax.html
http://lucene.apache.org/java/docs/queryparsersyntax.html
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To use this feature you need to have the access to the P2P coordination server. Since document
sharing is targeted primarily at members of intranet teams, you can download and install the Knorg
Server package from our site, http://www.knorg.net (it requires Windows Server 2000 or 2003, Internet
Information Server and SQL Server 2005 or SQL Server Express). The list of publicly available Knorg
servers is also published at the same address.
Note that you will have to allow access to the "sharing port" (default port number is 8000) at your local
machine. This setting can be configured in the program settings.

Network search in Knorg is very efficient due to the fact that program dynamically registers
"signatures" of your shared documents on the P2P server. Every full-text search request is being
compared with these signatures and the list servers that match the search criteria is returned to the
client. The actual search on returned peers is performed in parallel by sending requests directly to the
peer addresses. This process is highly asynchronous, so Knorg will dynamically report the search
status while it is in progress.

5.8 Importing bookmarks

Knorg enables you to easily import bookmarks from all major Web browsers that support Netscape
bookmark file format (including Internet Explorer and Firefox). The process is rather straightforward:
you have to export links from the browser to a HTML file and import this HTML file to Knorg. 

In Internet Explorer choose File -> Import and Export -> Export favorites, choose a source folder and a

http://www.knorg.net
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target file location.
In Firefox choose Bookmarks -> Manage Bookmarks, and than choose File -> Export and enter a
target file location.

You are now ready to import bookmarks. Please select a category that will become a root of the
imported bookmark hierarchy, choose Folder -> Import Bookmarks and select a bookmark file that you
have created in the previous step. Knog will start to download content from the links contained inside
the bookmark file. This can be a lengthy process, depending on the size of the bookmark file and your
network bandwidth. You can always check the current status by activating download queue dialog
screen.

5.9 Exporting links

As Knorg fully supports tagging mechanisms that were made popular by various Web 2.0 services
such as del.icio.us, it is natural that it also allows you to export archived links and attached tags to
such services. 
Before you start, it is important that your account at del.icio.us is properly set up and that your
username and password are entered in the program settings. Exporting links is a single-step process:
just select a category that you want to export and choose Folder - Export to del.icio.us. Again, this
process can consume quite a bit of time, depending on the number of links in the selected category
and your network bandwidth (note that del.icio.us imposes a mandatory delay of approx. 1 second
between each upload).

http://del.icio.us
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6 Frequently Asked Questions

What makes Knorg different from tools like Windows Desktop Search and
Google Desktop? 
This question is easy to answer, but the answer is not short...
· Knorg allows you to create document hierarchies and neatly organize the contents of your

knowledge store. All files are placed to appropriate places, with or without user's involvement.
· Knorg can interpret user rules.
· Knorg can auto-categorize your documents.
· You don't have to use full-text search exclusively like in desktop search products: you have an

organized hierarchy which is really easy to navigate, and user-defined tags add an alternative way of
navigation. 

· Knorg allows you to tag and annotate documents.
· Knorg automatically downloads on-line materials and can save it single-file archives (no more messy

multi-folder copies of Web pages).
· Knorg can listen to the system clipboard and pick only URLs or files that are relevant to it (other

clipboard content is disregarded).
· Knorg allows you to share documents, tags and annotations with other users, allowing you to easily

build knowledge-sharing teams.
· Knorg can import bookmarks from a Web browser and create a live document store instead of list of

URLs without any content.
· Knorg can export links to del.icio.us.
· the list could go on and on... In a nutshell, Knorg is a document organizer that will help you to easily

download, retrieve and manage unlimited number of files stored in their native formats.

What are the prerequisites for installing Knorg?
Knorg requires an active installation of Microsoft .NET framework 2.0 (.NET framework runtime can
be downloaded here). There are no other requirements.

How can I set up the Knorg P2P server?
Server component can be purchased at our site, http://www.knorg.net. Please note that it requires .
NET 2.0 runtime, Internet Information Server and SQL Server 2005. Detailed installation instructions
are available in the server setup package.

Which format do you use to store files? 
Files are actually stored in your file system, and the root of your knowledge base can be easily
changed in the program settings section. HTML files that Knorg downloads from the Web are
automatically converted to the single-file MHTML format which makes it much easier to manage them
when compared to ordinary, multi-file HTML archives.
All relative links in the Web page are remapped and the embedded content is included in the .mht file,
rather than being saved in a separate folder. The absolute references or hyperlinks on the Web page
remain unchanged. MHTML enables you to embed images directly into the body of your files rather
than attaching them as external resources.

See more details on MHTML format on Wikipedia.

All files can be accessed "from the outside" without any special viewers (MHTML files can be used
with all major browsers, and files in other formats can be used with their own native viewers).

What is stored in a database that is installed during the installation? 
MS Access or SQL Server database that is installed during the setup holds tags, descriptions,
document vectors, and other data that cannot be stored reliably in the file system. This is necessary in
order to enable the peak performance for larger knowledge bases. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en
http://www.knorg.net.
http://en.wikipedia.org/wiki/MHTML
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Why the "Incoming" folder cannot be deleted?
This is a special system folder that is constantly monitored by Knorg. Each file that is dropped here will
be moved further to the appropriate category, according to user rules or using auto-categorization
algorithm.
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